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1 Introduction
Welcome to OSHPD Electronic Services Portal Client Access (eCA) User Guide

This section of the user guide provides an overview of the OSHPD Electronic Services Portal Client Access
program, also referred to as eCA.

Throughout each of these user guides you will see screenshots of the various pages and sections you will
use to navigate and enter application information. Help is available throughout the application.
Wherever you see a helpicon, 7y click on the question mark to open help and instructions for that
item in the application. -

2 eCA System Overview

eCA is an online system that allows the facility representatives and licensed professionals to submit
various applications for projects directly to OSHPD. eCA enables public users to register for an online
account, manage their accounts, create applications for projects and other records, submit project
applications directly to OSHPD, pay application fees, and track the application status.

eCA is accessible to all public users via the internet at https://eserv.oshpd.ca.gov/CitizenAccess/. To

perform the ‘core functions’, users must register for and obtain a public user account. Once project
application is submitted to OSHPD via eCA, the information is immediately available to OSHPD and can
be viewed (only) by the public.

2.1 eCA Functionality

Public users can navigate the eCA system simply by following the various links in the system and clicking
on specific buttons to perform various tasks. eCA consists of two main functional areas: “anonymous
users” and “registered public users”. Figure 1 below illustrates the main functionalities in each group.

Figure 2.1 - eCA System Functionality Map

eCA System Functionality Map
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2.2 eCA Navigation
Figure 2 below illustrates the available web pages in the eCA system and the navigation path users must
follow. User must log in eCA to create and submit project applications.

Figure 1.2 - eCA Navigations

eCA Navigations
G |
eCA Home » Register for an Account —» Account Management
» Reset Password —> Collections
» Search Project —> Print Reports » Create an Amendment
_| Resume an Application
» Search Facility | (AFNP or Amendment)
—> My Projects list —
N Create an
> i » Pay Fees Due —>|
Login Amendment
—>» Search Project » Record Details » Print Reports
—» Search Facility —>» Pay Fees Due
Create an Application
L
For a New Project (AFNP)
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2.3 eCAlcons
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Table 1 below lists the common icons used in eCA.

Table 2.3 - eCA Icons

Icon

Description

Q K

Search a record in eCA orin a list

Help x
Enter your unique identifier for this submittal
If this is a Deferred ltem, this entry should
match exactly the entry in the Deferred Items
list in the parent Applicaiton for New Project.

Clickonthe (3 icon to display help instructions

State License Number:

Enter a valid State License

Watermark instructions are displayed in the data entry
field. When user puts the cursor in the field, the watermark
instructions are replaced by the data user enters.

i
A

/i *Project Name

Warns the user that there are errors in data entry fields on
the form which prevents the page from being saved. The
error message appears both on the top of the page and
next to the data entry field where there is an error.

Account Management Logout

Hyperlinks are displayed with blue-colored text.

q Facility
Information

2 Professionals and
Contacts

3 Project Details

Steps in application process, also referred to as “bread
Crumbs”, that show you where you are in the process.
e Blueicon indicates the current step.
e Yellow icon indicates the steps that remain to be
completed.
e White icon with underlined text indicates the
completed step(s) which are also available for
editing.

*Cost Date:
11/04/2016

Su Mo Tu We Th Fr Sa

1 2 3@ s

6 7 8 9 10 11 12

13 14 15 16 17 18 19

20 21 22 23 24 25 26
27 28 29 30

Today: October 30, 2016

Click on the calendar picker to display the current month.
Click any date to populate the date field in the proper
format.

Save pending submittal

Click on the Save pending submittal button to save the
application in progress before submittal to OSHPD. eCA
generates a temporary project record for the application.

Click on Continue Application button to proceed to the
next step of the application process.

Clear

Continue Application »

Click on the Clear button to clear data that has been
entered but not saved on the screen.
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Cancel Discard Changes Click on the Cancel or Discard Changes link to cancel
current task being performed on the screen.

Click on the Submit or Save and Close button to save the
Save and Close . .
data entered in the current section of the form.
k

Data entry is required for the field.

Windows Internet Explorer
o Are you sure you want to leave this
page?

Message from webpage:

Alerts the user that they are leaving the current page.

Your information has not been saved.

= Leave this page
—» Stay on this page

3 eCA System Orientation

This section provides an overview of the main page and basic system functions and features.

3.1 eCAHomeTab

The home tab is the main page for all user activity. It is the page presented to the users after they log
into eCA.

Figure 3.1 - eCA Home Tab

State of California

Office of Statewide Health Planning & Development

[ Search o

® This Site ) California

Q (C]

Announcements Logged in as:John Smith [ Accessibility Support  Collections (2] Account Management  Logout

G (G)

LIl Projects

@ Dashboard ® My Records (§) My Account (@ Advanced Search v

WelcomeJohn Smith
You are now logged in

You may view Facility information, search for projects that have already been created,
or create an application for a new project by clicking the links below.

Click the ‘Projects’ tab above to view all of the projects associated to your profile.

Instruction guides organized by subject are available by clicking the
“Instructions” tab at:
http://www.oshpd.ca.gov/FDD/eServices/index.html

Q
Facility Information Projects

ookup Facility Information te an Application

e Search Projects
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The home tab offers the following functionality and features.

A.

3.1.1

Breadcrumbs — The breadcrumbs show users “where they are” in the system. Users can click the
“Home” link to return to the Home tab. Note: if the user is in a project application, clicking the
“Home” link does NOT save the work in process.
Logged in User — eCA shows the logged in user name.
Collections — This link shows how many collections the user has created and provides a link to
the collections. Collections are a convenient and easy way to group projects you regularly work
on —similar to a My Favorites page.
Account Management/My Account — This link opens the user Account Management features
described in Section 4, such as Delegation, License Association and Password maintenance.
Logout — This link logs the user out of eCA.
Home Tab — Always visible on the main page, clicking on this tab takes the user back to the
Home screen.
Projects Tab/My Records Link — This tab will list all projects associated with the user account:
a. Projects/Records created by the user
b. Projects/Records associated with the user’s professional license
c. Projects/Records at the facilities associated to the user
d. Projects/Records associated to the user by delegation
Facility Information — This link below opens the facility search page.
Projects — This links below allow the user to begin the application process for New Project and
to conduct a general search.
Dashboard — This link displays the User’s personalized dashboard which includes a quick display
of Collections and all projects that are in-progress for easy selection and completion.
Search/Advanced Search — This link or selection opens the Projects tab to allow for searching by
project/record number, by Facility, by License Number, etc.

Collections

Collections are a convenient way to access projects that you work on more often than others and to sort

your projects into logical categories. Think of it as a “My Favorites” page or a “Quicklist”. Add projects

you work on frequently. Remove them when you’re done. Create categories that make sense to you,

like projects at Facility A, projects at Facility B, etc. You can add projects to the Collections from the

projects list as well as the search result.

3.1.1.1 Add Projects to Collections
Using any search results or from the Projects tab, users may add projects and records to their collections

by checking the box adjacent to the record and then click on the “Add to Collection” hyperlink. The user

will be able to create a new Collection or add to an existing Collection. See Figure 6.

eCA User Guide — Section 1: eCA System
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Figure 3.1.1.1 - Add to, or Create, Collections

Showing 61-70 of 100+ | Download results | Add to collection
|:| Date Project Numbeb’ Project Type Project Name Status Related Action
I' o
[] | osro7r2015 s1sqeeff10-00-8pToy  ApPlication for Irack Mounted Closed 2
’( Building Permit Supply Rack Install
- . .
@ 08/03/20]&' $152042-19-00 Application for RRU-ED Admin Pending Construction Start 2 Pay Fee
’I New Project Relocation Amendn
',’ RRU- UCLA RRUMC
P-2013-00243- Post Approval Clinical Laboratory-
D QCl22/2000 ACDO0005 Document Equipment Upgrade REREE 4
Project.
] | os/18/2015  s151641-19-00 Application for RR - Kitchen Time Closed 2
New Project Clocks
RRU-LA - Sterile
|:| 06/16/2015 S R [RESB A Processing Sonic Approved 5
ACDO0002 Document ; "
\ ), Washer installation

3.1.1.2 The Collections List
To open and view collections, click on the “Collections” hyperlink at the top of the screen.

Figure 3.1.1.2(1) - Open Collections

Announcements Logged in as:John Smith__ Collections (2)¥ Account Management Logout

m Projects

Dashboard My Records My Account Advanced Search =

Collections
This is a list of your collections. To manage a collection, click the link next to the collection name.

Showing 1-2 of 2

Date Modified Name Description Number of Records
10/30/2016 UC Irvine UCIrvine Medical 5 Delete
Center

UC San Diego Medical

Delete
Center 2 s

10/30/2016 ucsD

In the example above, this user shows two collections in their Collections list. Users can add or delete
projects/records to the collections, or completely delete the collections, without deleting or affecting
the underlying projects. Users can open the collections and work the projects as they would from the
main Project Tab. See Figure 8.
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Figure 3.1.1.2(2) - Sample Collection "My Projects

UC Irvine
UC Irvine Medical Center

Total Records: 6 (6 Projects)
Inspections Summary: 0 (0 Scheduled, 0 Rescheduled, 0 Approved, 0 Denied, 0 Pending, 0 Cancelled)

Fees Summary: $1,582.00 Paid, $0.00 Due
Rename Collection Delete Collection

Projects

Move to... | Copy to... | Remove
Showing 1-6 of 6 | Download results

Related

D Date Project Number Project Type Project Name Status Records Action
N 2880_B1, DH 76/78
[] 10/05/2016  s162543-30-00 e Medication Rooms, ~ Open 0 Amend
) Add Outlets
) 2981_B1A, ED
(] 10/03/2016  $162521-30-00 Application for Registration Pending Construction Start 2 Amend

New Project Consolidation
2954_B1, 2nd FL,

Room 2423, Work Pending Construction Start 3 Amendr
Flow Modification

Application for

[[] o09r29/2016  $162495-30-00 e

2949_B1, 5th FL, Rm

Application for 5600, Change of Use . . . .
:] 09/29/2016 5162496-30-00 New Project to EMU Monitoring Pending Construction Start 2 Amendr
Room
[] o08/25/2016  SER-2016-00207 AppforSeismic  Adding Bulldingto  iive _ plan Review 1

Eval Report Facility

3.1.2 Reports

eCA provides multiple ways to run reports. The easiest way to generate a report is from the project
summary because eCA passes information from the project summary to the report. The other way to
generate a report is from the reports hyperlink on the main page. The reports hyperlink allows users to
generate a Receipt for the Application Fee, a Preliminary Invoice (for projects which opt to “pay later”),
and the Project Application Summary. With the reports link it is necessary to provide the exact project
number or receipt number in order to generate the report.

Figure 3.1.2 - Reports

Announcements Logged in as:John Smith  Collections (2)¥ | Reports (6) ¥ | Account Management Logout

Reports (6):
AMC and PAD
Invoice Aging Report
Preliminary Invoice
Professionals by Project
Project Application Summay
eCA Payment Receipt

eCA User Guide — Section 1: eCA System
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3.1.2.1 Project Summary Sheet/Transmittal

The project summary sheet provides users with a printable summary of the project. This report should

IM

be included as the Transmittal for al
the office or to the field.

Figure 3.1.2.1(1) - Project Summary Sheet - Generate from Project Summary

Step 7:Confirmation

Your application has been successfully submitted.
Please print your record and retain a copy for your records.

enclosures” submitted to OSHPD, whether they are submitted to

Thank you for using eClient Access to submit your application for post-approval document.

Your Post-Approval Document Number is $162557-37-00-ACD0001.

You will need this number to check the status of your project. Please print a copy for your records.

Print/View Project Print/Vliew Summary

3.1.2.2 Print Receipt

If the user pays by credit card, the user may print the receipt
at the time of payment or later, provided the user saves the
receipt number.

Figure 2.1.2.2(1) - Print Receipt

Confirmation

You have paid a fee associated to this Record.
Please print a copy of this receipt and retain a copy your records.

Thank you for using eClient Access to process your payment.
Your Record Number is $162557-37-00-ACD0001.

You will need this number to check the status of your project, Please print a copy for your records.

Print/View Project Print/View Receipt Print/View Summary

eCA User Guide — Section 1: eCA System
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Figure 3.1.2.1(2) - Sample Project Summary Report

‘. OFFICE OF STATEWIDE HEALTH PLANNING AND DEVELOPMENT
iy FACILITIES DEVELOPMENT DIVISION

Praject Number: SI62357-AT0i-ACTXIN0]
Project Type: Post Approval Document
Parent Profect Number:  $161357-37-001
Facility: L1659 - TCSD Lo Jolla, Tol MiSally B Thorston Hosp & Sulpizio C: ular Ctr
Praject Description: me 6085 Icobs Sink installation R 1.1 -453
Vo remove two preces of equipment and install utility sink i soiled work reom 11953
Applicant Tracking No:  ACD (1
Submittal Type: mended Construetion Document
Reasan for Change: Reason for change

Seope of Change: Scepe of chingze.
Description of Proposal:

Primary Professtonal:  Francois M. Lewis. (619) 7250050 testingespi@odhpd ca gov

Primary Contact: TetesaTraseo

Cost Type  Cost Date. Consweuction  Fived Equipment Total Cost Cosit of Reason
Cost Casts Imaging

Estnunled 10302016 oo so00 So0a S0.00

Enclosures:

Hof  Inclasure Descripitan DateSens Methadof  Courfer  Backeheck  Aached
Captes Type Transmitial Name

Flease ncude this roject Application Sumary orut it out: cousrition doctuuents when submlting fo
OSHFD, Thls Project Applcaton Soramary er applcaion: I 1 ot necssarytonclade he
paper application when project applications nt A

$162557-37-00-ACD0001
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Figure 3.3.2.2(2) - Sample Receipt

REMIT TO:
UCSD La Jolla, John M/Sally B Thornton Hosp ~ Office of Statewide Health Planning and Development
& Sulpizio Cardiovascular Ctr Accounting Office
9300 Campus Point Dr 400 R Street, Ste 359
La Jolla, CA 92037 Sacramento, CA 95811-6213

Project related questions contact - Facilities Development Division (916) 440-8300 or (213) 897-0166
Billing related questions contact - Accounting Services (916) 326-3236, Fax (916 322-2527)

Facility Name: UCSD La Jolla, John M/Sally B Facility Number: 11659
Thornton Hosp & Sulpizio
Cardiovascular Ctr

App Tracking: Project Number: S162557-37-00-
ACDO0001
Scope of Change: Scope of change. Parent Number: S162557-37-00
|Fee Item Description Invoice #/Date Amount Amount Due |
Application Fee 190770 - 10/30/16  $250.00 $0.00
|Transaction Receipt Nbr ~ Payment Method  Payment Ref# Date Amount
Receipt 124901 Credit Card 10/30/2016 $250.00
PLEASE PAY THIS AMOUNT ——-—--—-—--—--—--> BALANCE $0.00

3.1.2.3 Preliminary Invoice

The preliminary invoice report is for users who opt for the “pay later” option when creating the project.
The pay later option enables users to submit a project without generating an invoice from OSHPD (the
traditional payment method) or paying immediately with a credit card. Users who select “pay later” can
print the preliminary invoice and have another registered user, who is authorized to pay with a credit
card, use the information on the preliminary invoice to find the project and make the payment. If the
application fee is not paid within 10 calendar days, OSHPD will automatically issue an invoice to the
facility’s billing contact.

eCA User Guide — Section 1: eCA System
Overview
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Figure 3.1.2.3 - Sample Preliminary Invoice

REMIT TO:
FACILITY: Office of Statewide Health Planning and Development
UCSD La Jolla, John M/Sally B Thornton Hosp Accounting Office
& Sulpizio Cardiovascular Ctr 400 R Street, Ste 359
9300 Campus Point Dr Sacramento, CA 95811-6213

La Jolla, CA 92037

Project related questions contact - Facilities Development Division (916) 440-8300 or (213) 897-0166
Billing realted questions contact - Accounting Services (916) 326-3236, Fax (916) 322-2527

Facility Name: UCSD La Jolla, John M/Sally B Thornton Hosp & Facility #: 11659

Sulpizio Cardiovascular Ctr
Project Description: 5020 MCLJ TH Emergency Dpt. & Radiology Intake Project # S162640-37-00

Ctr
App Tracking #: Parent #:
Scope of Change:
Construction Cost: $9,750,000.00 Fixed Equipment Cost: Radiological Cost: $0.00

$2,180,000.00

Fee ltem Description Date Amount Amount Due
Application Fee 10/19/2016 $250.00 $250.00

Please log in to https://eserv.oshpd.ca.gov/CitizenAccess/ to submit your credit card payment online.
You can submit the invoice number and your credit card information to our secure email at ePayments@oshpd.ca.gov

PLEASE PAY THIS AMOUNT --------mmmmmmee >  BALANCE $250.00|

3.1.3 Account Management
User Account Management is detailed in Section 4.

Announcements Logged inas:John Smith Collections (2)¥ Reports (6) ¥ (Ar_'count Management] Logout

3.1.4 Logout
Logout logs the user out of eCA so another user may log in. It is a recommended practice to log out
when users conclude their session.

Announcements Logged in as:John Smith Collections (2)¥ Reports (6) ¥ Account Management

3.1.5 Home Tab - Facility Information
The Lookup Facility Information hyperlink on the Home tab enables logged-in users to look up facilities
by facility number, county code, geographic region, and responsible region (i.e. OSHPD Region).

eCA User Guide — Section 1: eCA System
Overview
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Figure 3.1.5(1) - Facility Information

WelcomeJohn Smith
You are now logged in.

You may view Facility information, search for projects that have already been created,
or create an application for a new project by clicking the links below.

Click the 'Projects’ tab above to view all of the projects associated to your profile.

Instruction guides organized by subject are available by clicking the
“Instructions” tab at:
http://www.oshpd.ca.gov/FDD/eServices/index.html

Facility Information Projects

[Lookup Facility Information) Create an Application

Search Projects

eCA uses “Parcel” and “Facility” interchangeably.

Figure 3.1.5(2) - Facility Look up Information

Look up Facility Information

Enter information below to look up Faciility information from the eServices Portal database. Property information can be searched for by
entering any of the following information:

Look Up by Parcel Information

Facility Number:

Responsible Region: Type of Facility:

--Select-- v --Select-- v
Geographic Region: County Code:

--Select-- v --Select-- v
RCO: ACO: DSE: Field FLSO: Closure PT:
Senior Plan Review
Architect: PT:

eCA User Guide — Section 1: eCA System
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The following screenshot shows the results for a facility search. The screen shows general information

about the facility.

Figure 3.1.5(3) - Facility Search Results

1 results found matching lookup criteria

Click any of the results below to view more details.

Showing 1-1 of 1| Download results

Facility Number Facility Status Action

11659 Enabled Retrieve Address & Owner Info
Facility Address
Showing 1-1 of 1| Download results

Address

9300 Campus Point Dr, La Jolla CA 92037

Facility Owner

Showing 1-1 of 1 | Download results
Name

11659 - THE REGENTS OF THE UNIVERSITY OF
CALIFORNIA

Address

1111 FRANKLIN STREET, 12TH FLOOR OAKLAND CA 94619

3.1.6 Home Tab - Projects
The Projects links on the Home
Tab allows the user to either
create a new application for a
new project (AFNP) (Section 5) or
to search for projects/records
that have already created (Section
6). The Search Projects hyperlink
takes users to the Projects Tab.

Figure 3.1.6 — Projects Links

Welcomedohn Smith

You are now logged in.

You may view Facility information, search for projects that have already been created,

or create an application for a new project by clicking the links below.

Click the 'Projects’ tab above to view all of the projects associated to your profile.

Instruction guides organized by subject are available by clicking the

"Instructions” tab at:
http://www.oshpd.ca.gov/FDD/eServices/index.html

Facility Information Projects

Lookup Facility Information Create an Application

Search Projects

eCA User Guide — Section 1: eCA System
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3.1.6.1 Create and an Application
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The Create an Application link takes users to create a new Application for New Project (AFNP). See

Section 5 for more information

3.2 Projects Tab
The Projects Tab is the main workspace for most users. It presents users with all projects associated with

their user account. Associations are created by:

Figure 3.2 - Project Tab

License — See user account management.

Delegation — See user account management.
Association with a Facility — Established by submitting the OSH-FD-310 - eCA Letter of

Authorization.

Created — Projects created by the user.

Create an Application Search Projects
Projects
Showing 1-10 of 100+ | Download results | Add to collection
El Date Project Number Project Type Project Name Status Related Action
] [ — . , Post Approval mcl6088 Jacobs Sink -
|| 10/30/2016 $162557-37-00-ACD0001 Da irent installation Rm LL.483  ©OPen 3
[] 10/21/2016  16TMP-015585 EOSt Approval 0 Resume Applica
—J ocument
o . 2981_B1A, ED
10/20/2016  5162521-30-00-BPTO1 Gy Registration Approved 2
e Building Permit S
Consolidation
— Application for 2949_B1, 5th Fl, Rm
10/20/2016  5162496-30-00-BPTO1 PPl ! 5600, Change of Use to  Approved
— Building Permit L2
EMU Monitoring Room
o At G 2954 _B1, 2nd FL, Room
[] 10/20/2016  5162495-30-00-BPTO1 Ezﬁdm . 2423, Work Flow Approved 3
9 Modification

3.2.1.1 Search Projects - General Search
Users can search for any projects in the eCA system via the search page. See Figure 20.

To obtain the best search results, limit the number of fields in the search. For instance, to search for a

project, enter only the project number and leave the Facility and State License Number fields empty.

The search results will return all records with that project number, including AMCs, PADs and BPs —

whether those records are open or closed.

eCA User Guide — Section 1: eCA System
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Search results can be limited by filtering the search using the Project Type drop-down list. Entering the
project number and selecting ‘Application for New Project’ in the drop-down list will result in only the
parent project record. If the project is an Incremental project, select ‘Incremental — New Building —
Master’ from the drop-down list.

If your search returns ‘No Results’, try removing the ‘Start Date’ filter and searching again.

Figure 3.2.1.1 - Project Search - General Search

Search for Projects

Enter information below to search the eServices Portal database. Project information can be searched for by entering any of
the following information:

« Facility ID Number
+* OSHPD Project Number

» Professional Licensee Information

Use the dropdown menu to filter the search results by Project Type.

General Search General Search

|:| Search my records only

Facility ID Number: Project Number: Project Type:
--Select--

License Type: State License Number: ~ Start Date: (7) End @)

—-Select-- 10/31/2014 Date:

10/30/2: ’

INCREMENTAL MASTER
Seismic Compliance Construction Project: () Yes (O No

PLAN REVIEW

Seismic Compliance Construction Project: (O) Yes () No

=3

eCA User Guide — Section 1: eCA System

14
Overview



OSde “Equitable Healthcare Accessibility for California”

3.2.1.2 Search Projects -Search by Licensed Professional

Users may also search for projects by license professional information. This search is flexible. It allows
users to search by license type and/or license number. When searching for a license number, eCA allows
for the entry of partial license numbers (e.g. “C223” instead of “C22341"). It also allows wildcard
searches (e.g. “C223%”").

Figure 3.2.1.2 - Project Search - Licensed Professional

Search for Projects

Enter information below to search the eServices Portal database. Project information can be searched for by entering any of
the following information:

« Facility ID Number
= OSHPD Project Number

» Professional Licensee Information

Use the dropdown menu to filter the search results by Project Type.

Search by Licensed Professional Information | Search by Licensed Professional Information™ I

[[] Search my records only

License Type: State License Number:

--Select-- ¥

eCA User Guide — Section 1: eCA System

1
Overview >



	1 Introduction
	2 eCA System Overview
	2.1 eCA Functionality
	2.2 eCA Navigation
	2.3 eCA Icons

	3 eCA System Orientation
	3.1 eCA Home Tab
	3.1.1 Collections
	3.1.1.1 Add Projects to Collections
	3.1.1.2 The Collections List

	3.1.2 Reports
	3.1.2.1 Project Summary Sheet/Transmittal
	3.1.2.2 Print Receipt
	3.1.2.3 Preliminary Invoice

	3.1.3 Account Management
	3.1.4 Logout
	3.1.5 Home Tab – Facility Information
	3.1.6 Home Tab – Projects
	3.1.6.1 Create and an Application


	3.2 Projects Tab
	3.2.1.1 Search Projects – General Search
	3.2.1.2 Search Projects –Search by Licensed Professional



